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What is BlackBerry Access?

BlackBerry Access for Windows is a secure browser that allows you to access your organization's intranet and
business applications on your Windows device. BlackBerry Access for Windows includes the following features:

Provides easy content downloads, bookmarks, and tabbed browsing

Supports pop-ups that facilitate the deployment of web apps, such as Cisco WebEx, Salesforce, and custom-
developed apps

Allows you to view streaming video with intuitive player controls built into the browser

Deploys your organization's HTMLS desktop apps securely and provides you with offline access to them
Secures work web apps in containers, ensuring that data never leaves your organization's control

Leverages standard end-user authentication, such as SSL, NTLM, and TLS

Supports credential persistence

Uses PAC file web addresses for secure routing of work data

BlackBerry Access for Windows also provides you with access to BlackBerry Work (email, calendar, and contacts)
from the web toolbar in BlackBerry Access.
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System requirements

For BlackBerry Access device OS compatibility, see the Mobile/Desktop OS and Enterprise Applications
Compatibility Matrix.

Your Windows device must meet the following requirements:

Computer with a minimum of 4GB of RAM
Computer with Intel Core i5 or later
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Installing BlackBerry Access

Visit https://ca.blackberry.com/support/business/enterpriseapps/blackberry-mobility-suites#Downloads to
download and install BlackBerry Access on your device.

Note: Windows 10 may block you from upgrading BlackBerry Access. If you are using Windows 10 and are
upgrading BlackBerry Access, run the BlackBerry Access installer as an administrator to avoid this issue.
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Activating BlackBerry Access

You must activate BlackBerry Access before you can use it. Activation is a one-time process in which you enter
your email address and access key. Activation details are provided by your administrator in an activation email.

Before you begin:
+ Install BlackBerry Access.
Locate the activation email from your administrator.

1. Open BlackBerry Access.
2. In the Email Address field, type the email address specified in the activation email.

3. Inthe Access Key field, type the access key specified in the activation email, without hyphens. The access key
is case sensitive.

4. Click GO.
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Uninstalling BlackBerry Access

To uninstall BlackBerry Access, you must uninstall it from the Control Panel.
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Installing BlackBerry Work

BlackBerry Access gives you access to mail, calendar, and contacts using BlackBerry Work from the web
toolbar in BlackBerry Access. BlackBerry Work is deployed as a web extension to BlackBerry Access.

BlackBerry Work is installed or uninstalled with BlackBerry Access, and no additional installation steps are
required.

When prompted, enter your Microsoft Exchange credentials (email address, username or User Principal Name,
and mail server password). Make sure that you accept the user agreement. BlackBerry Access then configures
mail, calendar, and contacts for you using your Microsoft Exchange credentials. If the autoconfiguration

fails, BlackBerry Access displays an error message.
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Using BlackBerry Access

Users can access the following features:

Feature Details

Printing If your administrator allows it, you can print web pages, pages from web apps
(email messages, calendar, contacts), and downloaded files. Click E and select
Print.

Download files You can download files in BlackBerry Access. Tap or click the Downloads

button or tab to view downloaded files. You can also preview downloaded files
from the download page.

The Download Manager is in the BlackBerry Access toolbar for easier access.

Click 1 to access your downloaded files.

If your administrator allows it, you can download files directly to your system's
default download folder and bypass the BlackBerry Access secure container.
You can also import files from and export files to the native file system
outside of the secure container.

In BlackBerry Access, you can also perform a local search of web addresses in
downloads.

Preview downloads You can preview downloaded files from the download page. Preview is
supported for Microsoft Word, Microsoft Excel, and Microsoft PowerPoint
formats, as well as PDF and common image formats (JPG, PNG, GIF, TIFF,
and BMP). You can preview downloaded files both inside and outside of

the BlackBerry Access secure container. Click ! in the window toolbar to
access your downloaded files.

Note that copying text and hyperlinks are not supported when you view a
download preview. Password protected files, .csv files, or split pages for
Microsoft Excel files (XLS, XLSX) are not supported.

Organize downloads The File Manager allows you to create and manage local folders in BlackBerry
Access. You can also edit, move, rename, export (depending on the policy your
administrator has set), securely edit, and delete files and folders.

Click the File Manager icon to open the file manager. In the file manager, right-
click to access the menu options.

Drag and drop files If your administrator allows it, you can import files from outside of the
BlackBerry Dynamics secure container into the file manager folders (for
example, in the file list, shortcuts, specific folder, and your system folders).
You can also import the file into a folder using breadcrumbs. If a file is
imported to a folder that already contains a file with the same name, a number
in parentheses is appended to the file name.
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Feature Details

Bulk action items You can select files and folders in File Manager list view and apply an action
for the selected items from the available bulk actions that are displayed. The
bulk actions that are displayed depend on the items that you have selected.
For example,

+ If you select one folder, you can rename, move, delete, and pin the folder.

+ If you select one file, you can open the file in secure edit, export, rename,
copy, move, or delete the file.

+ If you select multiple files, you can export, copy, move, or delete the
selected files.

+ If you select one or more files and folders, you can move or delete the
selected files and folders.

+ If you don't select a file or folder, you can create new folders in the Local
folder.

View file and folder details You can view the following details when you select individual files and folders
in the File Manager. Detail information is not displayed if multiple items are
selected. You can view the following information:

*  Files

+ Image preview or a file type icon for non-image files. Note that if a file
is larger than 5 MB a generic file icon is displayed instead of the image

preview.
+  File type
Last modified date
+ File size
+ Folders

+ Folder name Generic folder icon
«  Number of items contained in the folder
Last modified date

Edit Microsoft Word and If you have the required license, you can securely edit Microsoft Word and
Microsoft PowerPoint Microsoft PowerPoint file attachments and you can annotate pdf files. If you
do not see the option to edit these files, you do not have the required SED.SU
- Secure Editing of Office Documents (Word, PPT and Excel) license. Contact
your administrator if you require this feature.

Share links in email To send a link using BlackBerry Work, right click on the link in the address bar
messages and select Share link with email.
Multiple windows support Users can access BlackBerry Work mail, calendar, and contacts in separate

windows. BlackBerry Access supports multiple browser windows.

History You can perform a local search of web addresses in the BlackBerry Access
history.
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Feature Details

Search engine links In BlackBerry Access, your administrator can add search engine links to the
browser. If your administrator configured this feature, you see search engine
links at the end of your search results in bookmarks, history, or downloads.
These links give you easier access to search engines when you perform
searches.

Third-party app extensions If your administrator allows it, you can download extensions for third-party
apps such as Cisco WebEx that can be launched from BlackBerry Access.
Your administrator determines the websites that you are allowed to download
extensions from.

Unqualified domain names Your administrator can define a default Internet domain and allowed domains
for you to use in BlackBerry Access. This allows you to reach servers by typing
the unqualified domain names instead of the FQDN.

For example, if your organization has an internal server running knowledge
base software with an FQDN of kb.example.com, your administrator can
configure domain information so that you can reach that server by simply
typing "kb" in the browser.

Cisco WebEx If your administrator allows, BlackBerry Access supports Cisco WebEx.

Cookies BlackBerry Access supports both persistent and non-persistent cookies. In
general, these are used to maintain session information.

WebSockets BlackBerry Access supports WebSockets (RFC 6455).

Languages BlackBerry Access navigation is available in English, Dutch, French, Japanese,
Korean, Simplified Chinese, and Swedish. This applies to the controls of
BlackBerry Access. Webpages are rendered in the language they are written in.

Skype You can open Skype meetings in BlackBerry Access.

View console logs You can examine the BlackBerry Access built-in console log to see possible
causes of difficulties that you might encounter. For example, if you cannot
access a particular website, you can view the console messages to see if your
access has been blocked by your administrator. If your administrator blocked
your access to a website, the console might display a message similar to this:

14:11:05 10/02/2014 Content from sync.example.com is blocked. Click : and
select Console logs.

Supportability notes

Item Details

File types BlackBerry Work does not support the following file types:

+ .msg: Microsoft Outlook message format
+ .zip: Compressed file archive
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Plug-ins

BlackBerry Access does not support the following plug-ins:

*  Microsoft ActiveX
+ Adobe Flash
+ Applets

| Using BlackBerry Access | 14



Manage settings for BlackBerry Access

1. 0On the toolbar in BlackBerry Access, click I
2. Click Settings.
3. Inthe General section,choose from the following options:

Task Steps

Send Logs to Server When selected, log files are uploaded to the server that
manages BlackBerry Access .

Change Password Select this option to change the BlackBerry Access password.
Import bookmarks You might see preloaded bookmarks that your administrator set
in BlackBerry Access . If your administrator allows it, you can import

bookmarks that you exported from other browsers.

Clear browsing data Select this option to clear browsing data including passwords, cached
files, browsing history, download history, and so on.

Manage passwords Select this option to view a list of websites that have saved passwords
or to delete saved passwords.

Enable detail logging When this option is selected, detailed logging in enabled in the in
console log.

4. In the Appearance section, choose from the following options:

Task Steps

Show home button When enabled, a home icon appears in the toolbar that links to the
home page.

Show bookmarks bar Select the "Always show bookmarks bar" option so that the bookmarks

bar always appears.

Font size Changes the size of the font in BlackBerry Access and BlackBerry
Work.

Customize fonts Changes the font.

Page zoom Specifies the level of zoom to use when viewing web pages.

Pressing Tab on a webpage Press the tab key to highlight links and form fields.

highlights links, as well as form

bars

Show warning before quitting If you close the app with Ctrl-Q, a warning is displayed.

with Ctrl-Q

5. In the Search engine section, choose from the following options:
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Search engine used when This option specifies which search engine to use when typing search

searching from the omnibox content in the browser address bar.

Manage search engines This option allows you to set which search engine to use as your
default.
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Using BlackBerry Work

BlackBerry Work for Windows is integrated as a web extension to BlackBerry Access for Windows. This simplifies
installation, configuration, deployment, and day-to-day use. BlackBerry Work for Windows allows you to use
BlackBerry Work mail, calendar, and contacts features in BlackBerry Access.

BlackBerry Work offers the following features:

Feature

Description

Sort email messages

You can sort email messages by subject, sender, and date. To sort
the contents of your email folders, click the Subject, Sender, or Date
column headings.

Attachments

+ You can upload, download, and forward attachments, as well as
save attachments to draft email messages. Attachments are also
supported in the calendar.

* You can attach multiple files to an email message, if the files
are already stored in the BlackBerry Access secure container. If
your administrator allows, you can attach files that are not in the
BlackBerry Access secure container.

+  You can securely preview file attachments before you download
them and securely view file attachments after they are
downloaded. Secure preview and view are supported for
Microsoft Word, Microsoft Excel, and Microsoft PowerPoint
formats, as well as PDF and common image formats (JPG, PNG,
GIF, TIFF, and BMP). Note that you cannot copy text or click
hyperlinks when you view a preview. The secure preview and view
feature does not support password protected files, .csv files, or
split pages for Microsoft Excel files (XLS, XLSX).

+ If you have the required license, you can securely edit Microsoft
Word and Microsoft PowerPoint file attachments and you can
annotate pdf files. If you do not see the option to edit these
files, you do not have the required SED.SU - Secure Editing of
Office Documents (Word, PPT and Excel) license. Contact your
administrator if you require this feature.

Search

*  You can search for local email messages and contacts.

+ You can perform actions, such as replying, forwarding, and
updating, from the search results.

+ Auto-complete is supported for searches. You will see
suggestions from local and cached contacts, as well as email
addresses from sent email messages.

Printing

If your administrator allows it, you can print web pages, pages from
web apps (email messages, calendar, contacts), and downloaded

files. Click E and select Print.
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Feature Description

Synchronization BlackBerry Work synchronizes all email messages, calendar events,
contacts, and folders with your work mail server. BlackBerry Work
displays a “Sync in progress” notification in the Inbox tab (on the left)
when new email messages are received.

BlackBerry Work has a Refresh button on the action bar in the email,
calendar, and contacts tabs. You can use this option to manually
initiate synchronization of email messages, calendar events, and
contacts, or send items from the Outbox folder.

Email features « Two-way synchronization of email messages between BlackBerry
Work and your work mail server, for the inbox, deleted, and sent
folders and subfolders

+ Skip to previous or next email message

+ Email message preview

« Auto-retrieve more email messages

+ Mark message as read or unread

+  Move email messages to or from any folder

+ Read HTML email messages

+  Compose HTML email messages (rich-text editor)
+ Compose more than one email message at a time
+ Type-down addressing

+ Filter email messages

« Spell check

+ Add a classification and caveat to an email.

+ Set high or low importance.

+ Sort email messages by conversation

« Drag and drop email messages

Quick access to user profiles from You can click a user name in an email header and open a pop-up
email messages window that displays options to view the user’s profile or to send an
email to the user.

Contacts features « Two-way synchronization of contacts between BlackBerry Work
and your work mail server

+ Look up email addresses in a Global Access List

+ Add contacts
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Feature Description

Calendar features + Two-way synchronization of calendar items between BlackBerry
Work and your work mail server

+ Create and update meetings (both recurring and non-recurring)

+ Create content with conference details that you can automatically
add when creating a meeting.

+ Respond to meeting invitations (accept, tentative, decline)

« Change meeting invitation responses (accept, tentative, decline)

+ Show your acceptance status in different colors

+ Remove meetings from cancellation emails

+  View day, week, and month views of your calendar

+ Reply to and forward events in the calendar

+ Bookresources, such as meeting rooms, in the calendar

+ See calendar availability indicators for recipients and resources
when creating calendar events

+ Spell check

Avatars BlackBerry Work synchronizes user images in email messages and
contacts if they exist in the GAL. If no image is available, the user's
initials are displayed instead. The color assigned to the avatar is
random.

Streaming notifications Streaming notifications combine the functionality of push and pull
notifications. The mail app establishes a notification subscription
and the connection remains open for 30 minutes to allow the mail
server to push notifications. Webapps uses streaming notifications
for synchronizing email messages, calendar events, and contacts.
Streaming notifications are standard and supported by EWS.
Streaming notifications reduce the load on the Microsoft Exchange
Server and improve the overall performance.

Out-of-office notifications You can configure out-of-office notifications.

Diagnostics menu You can access a new diagnostics page in the Settings menu to view
information about the number of active and inactive tabs (including
email, calendar, contacts, and sync), to view status information about
tabs, to refresh tabs, and to test the connection with the Microsoft
Exchange Server.

Work offline You can use many BlackBerry Work features while offline. For
example, you can draft email messages or create calendar invites
that you can send when your Internet connection is restored.

Drafted email messages that are sent while you are offline are
displayed in the Outbox folder. You can choose to delete or save the
email message as a draft from the Outbox folder.

Send feedback to BlackBerry We value your feedback and use it to improve our products.
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Access your email messages, contacts, and calendar events

There are icons in the toolbar that give you quick access to your email messages, contacts, and calendar events.

On the toolbar in BlackBerry Access, select one of the following:

Task Steps

View and create email messages a. Click &4.

View, create, or edit contacts a. Click B.
View, create, or edit calendar a. Click[®.
events

Create an email message

1. On the toolbar in BlackBerry Access, click &4.
2. Click Create New Email.
3. In the To field, enter your intended recipients separated by a comma.

If your administrator has enabled the trusted domains feature, recipients with email addresses in untrusted
domains will appear in purple text.

Optionally, click the Cc or Bee links to copy additional recipients.
In the Subject field, enter a subject.

Type your email message.

To add an attachment, click =.

When complete, choose one of the following:

® No a

To save the email message as a draft, click the Save as Draft icon.
To add a classification to the email, click Set Classification.

If your administrator has enabled the require all emails to have an email classification feature, you must
select a classification before you can send your email message. Recipients see the specified Classification
under the Subject field.

To add a caveat to the email message, click Set Caveat.

Recipients see the Caveat under the Subject field.
To sign the email message, click the Sign icon

To encrypt the email message, click the Encrypt icon
To send the email message, click the Send button.

Create an email folder

Click &4 on the toolbar.

Click .

Select New Folder from the drop-down menu.

Type a name for the folder and select the folder you want to create this new folder in.

P N2
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5.

Click Create.

Rename an email folder

a0 NdN=

Click &4 on the toolbar.
Click .
Select Rename from the drop-down menu.

Type a new name for the folder.
Click Save.

Move an email folder

a0 b=

Click B4 on the toolbar.
Click .
Select Move To from the drop-down menu.

Select the folder you want to move this folder to.

Click Save.

Delete an email folder

1.
2.

3.

Click B4 on the toolbar.
Click .
Select Delete from the drop-down menu.

Create a calendar event

1. On the toolbar in BlackBerry Access, click [,

Click New Event.

Do any of the following. Phone numbers entered in fields will be displayed as links. You can add phone

numbers to any field (for example, in the Subject, Location, and Notes fields).

In the Subject field, enter a subject for the event.

Beside Start, specify the date and time for the event to begin .

Beside End, specify the date and time for the event to end.

If applicable, turn on the All Day indicator.

In the Resources field, add resources (for example, meeting rooms).

In the Location field, specify where the event will be held. You can enter a call-in phone number and
passcode here. A setting available in Calendar settings under Passcode causes any phone number in this
field to be displayed as the default. (Numbers in all fields are otherwise displayed as the default.)

To add required participants, in the Required field, begin typing a name. Select an attendee from the
available matches.

To add optional participants, in the Optional field, begin typing a name. Select an attendee from the
available matches.
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+ Add details about the event in the description field. You can make any formatting changes that you require.
] ﬁ.
Click #+ to configure the recurrence setting for the event. The default value is Does not repeat.
4. Click Create.

Create reusable conference details

You can create text, including links, that you can reuse when you are setting up a meeting.

On the toolbar in BlackBerry Access, click 5.

Click %%

Click Calendar.

Click the button beside Provide your conference details to streamline setting up meetings.
In the text window, type the conference details you want to reuse, and add any links.

Click Save.

When you set up a new event, click Add Conference Details. The conference details you saved are added to
the event. To delete the conference details from the event, click Remove Conference Details.

Noapsw b=

Respond to a meeting invitation

1. Click the meeting invitation that you want to respond to.
2. Choose one of the following options:

Task Steps

Accept the meeting request a. .
To accept a meeting request, click .
b. Choose one of the following options:

+ To send a custom message to the meeting organizer, select Edit
the response before sending.

+ To send the response without a custom message, select Send
the response now.

+ To accept the meeting but not send a message to the organizer,
select Don't send a response.

Tentatively accept the meeting a. m
request To tentatively accept a meeting request, click b
b. Choose one of the following options:

+ To send a custom message to the meeting organizer, select Edit
the response before sending.

+ To send the response without a custom message, select Send
the response now.

+ To tentatively accept the meeting but not send a message to the
organizer, select Don't send a response.
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Task Steps

Decline the meeting request a. E
To decline the meeting request, click .
b. Choose one of the following options:

+ To send a custom message to the meeting organizer, select Edit
the response before sending.

+ To send the response without a custom message, select Send
the response now.

+ To decline the meeting but not send a message to the organizer,
select Don't send a response.

Add a contact from an email message

You can add individuals to your contacts list directly from an email or manually. To add a contact manually—
typically someone that you have not received an email from—use the Quick Create Tool.

1. Open the email.

2. Click the name of the sender or one of the recipients.

3. When the Contact information screen opens, click +. This opens the contact form for editing with the available
information for this individual prepopulated.

4. Click Create.

Add a contact manually

You can add individuals to your contacts list manually—typically someone that you have not received an email
from.

1. On the toolbar of the window that you have open, click |8 .

2. Click New Contact.

3. Enter the details for the contact.

4. Click Create.

View and edit a contact

You can open contact entries from your window toolbar, from an email that you received from the contact, or from
a calendar event that includes the contact.
1. To open the contacts window, click [B from the toolbar.
2. Click @ to search for the contact that you want to view.
3. Click the contact that you want to view. You can view the following:
+ About: View details about the contact
+  Team: View the contact's role and team

+ Messages: View a history of your conversations with this contact
+ Files: View a history of files exchanged with this contact

| Using BlackBerry Work | 23



4. To edit the contact, click #" .
5. To delete the contact, click W .
6. To send an email message to the contact, click &4.

Create a contact group

Click B on the toolbar.

Click on the drop-down menu beside New Contact and select New Group.
Type a name and description for the group.

Add contacts to the Team list by typing a name to add it.

Click Create.

a bk oonN =

Edit or delete a contact group

Click 1B on the toolbar.

Click @ to search for a group.
Click the group.

To edit the group, click #".

g prwbd =

To delete the group, click B.

Create a signature

You can store a personal signature that is included at the bottom of new email messages.
Note: Your signature is not synchronized to the server and is available only on the device on which you set it.

On the toolbar in BlackBerry Access, click &4.

Click New Mail.

Click Settings.

Click Signature.

Turn signatures on by clicking the Off slider.

Enter your signature text in the textbox provided (text only, no HTML).
Click Save.

Noakwn=

Delete all data and account information

On the toolbar in BlackBerry Access, click &4.

Click Settings.

Click System Diagnostic.

Click Application Reset.

Read the warning message and click Yes to delete your data and account information.

ahwODd=
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Manage settings for BlackBerry Work

1. At the bottom of the left pane in BlackBerry Work, click Settings.
2. In the General section,choose from the following options:

Task Steps

Notifications Slide the Notifications setting to On to allow BlackBerry Work to send
you notifications when you receive new email messages.

Out of Office Messages Slide the slider to On to send automatic replies.
When this feature is turned on, configure the following settings:

+ To set a time period to send automatic replies, slide the Only during
specific time period setting to On and select the date range in the
From and To fields.

+ Inthe text box. type the message that you want to send to
recipients while you are sending automatic replies.

3. In the Email section, choose from the following options:

Task Steps

Signature Slide the Include my signature on messages | send setting to On to
automatically include a signature when sending email messages.

When this setting is turned on, type the email signature in the text box
that you want to include.

Sync By default, BlackBerry Work synchronizes email messages with your
mail server from the previous 2 weeks. If you receive a lot of email
messages, you can select a smaller synchronization time to improve
performance. Alternatively, you can increase the time limit if you
require. Choose from the following options:

+ Mail 1 Day back

+ Mail 3 Days back

« Mail 1 Week back

« Mail 2 Weeks back
« Mail 1 Month back
+ Mail 6 Months back

4. In the Send Feedback section, choose from the following options:

Task Steps

Send Feedback You can send feedback directly to BlackBerry. If you require
troubleshooting help, it is recommended that you select the Upload
Logs option to help with the troubleshooting process.

5. In the System Diagnostic section, choose from the following options:
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Task Steps

System Diagnostic You can generate a diagnostics report to help troubleshoot issues with
email, calendar, contacts, or your mail server connection. Click Start to
generate a report and then wait for the report to generate. If there are
any issues, click Fix This to allow BlackBerry Work to attempt to fix the
issue.

Application Reset Click Reset to delete all data and account information. Make sure you
read the warning message before you proceed.
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Securely edit files

If you have the required license, you can securely edit Microsoft Word, Microsoft Excel, and Microsoft PowerPoint
file attachments and you can annotate pdf files. If you do not see the option to edit these files, you do not

have the required SED.SU - Secure Editing of Office Documents (Word, PPT and Excel) license. Contact your
administrator if you require this feature.

Edit a Microsoft Word document

Note: If you do not see the option to edit these files, you do not have the required SED.SU - Secure Editing of
Office Documents (Word, PPT and Excel) license. Contact your administrator if you require this feature.

1. Open the file that you want to edit.
2. Choose from the following tasks:

Task Steps

Edit text a. Click the Edit tab.
b. Select the text that you want to edit.
c. Using the tools in the edit toolbar, change the required formatting
including font style, paragraph alignment, list formatting, and
indentation options.

Insert images a. Click the Insert tab.
b. Place your cursor where you want to add an image.
c. To add an image from your computer, click Image.
d. Choose the image to add.
Mark up the document If you are viewing a .docx file, you can use the following review
features:

a. Click the Review tab.

b. Click Author to enter the name that will be associated with the
changes that you make in the document.

c. Turn on Track Changes if you want to keep track of the changes
that you make to the document.

d. Turn on Show Changes to see all the changes that have been made
to the document.

e. Click Accept to convert the currently selected tracked change to
final text.

f. Click Reject to revert the currently selected tracked change to the
previous text.

g. Click Next to go to the next tracked change in the document.

Edit a Microsoft Excel document

Note: If you do not see the option to edit these files, you do not have the required SED.SU - Secure Editing of
Office Documents (Word, PPT and Excel) license. Contact your administrator if you require this feature.
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1. Open the spreadsheet that you want to edit.
2. Choose from the following tasks:

Task Steps
Insert a new row or column a. Click the Insert tab.
b. Place your cursor where you want to insert a row or column.

c. Ontheinsert toolbar, choose the insert option that you require.

Edit content in a cell a. Click the Edit tab.
b. Click the cell that you want to edit.

c. Using the tools in the editing toolbar, make any necessary
formatting changes.

Change cell size or merge cells a. Click the Format tab.

b. To change the size of a cell, select the cell and type a new width or
height or use the sliders.

Insert a formula a. Click the Formula tab.
b. Select the cell where you want to add a formula.

c. Onthe formula toolbar, choose the formula to insert using the
formula selectors or manually type a formula directly into the
formula bar.

d. Click Enter.

Edit a Microsoft PowerPoint document

Note: If you do not see the option to edit these files, you do not have the required SED.SU - Secure Editing of
Office Documents (Word, PPT and Excel) license. Contact your administrator if you require this feature.

1. Open the Microsoft PowerPoint presentation that you want to edit.
2. Choose from the following tasks:

Task Steps
Edit text a. Click the Edit tab.
b. Select the text that you want to edit.

c. Using the tools in the edit toolbar, change the required formatting
including font style, paragraph alignment, list formatting, and
indentation options.

Insert images, graphics, or a. Click the Insert tab.

shapes b. Place your cursor where you want to add an image.
c. To add an image from your computer, click Image.
d. Choose the image to add.

Change shape and line formatting a. Click the Format tab.

b. Select the shape or line that you want to format.
c. Change the object's fill color, line color, line weight, or line style.

| Securely edit files | 28



Task Steps

View slides a. Click the Slides tab.
b. Scroll through the slides.

View and annotate a PDF document

Note: If you do not see the option to edit these files, you do not have the required SED.SU - Secure Editing of
Office Documents (Word, PPT and Excel) license. Contact your administrator if you require this feature.

1. Open the PDF file that you want to edit.
2. Choose from the following tasks:

Task Steps

Add notes or mark up the PDF Click the Annotate tab.

To highlight text, select the text and then click Highlight .

c. Todraw in the pdf, click Draw. Use your mouse to add a freehand
drawing. After the drawing has been added, you can change the line
color or thickness.

d. To add a note, click Note and then click the location where you
want to add the note. Type your text in the comment bubble.

1

View pages in the PDF a. Click the Pages tab.
b. Scroll through the thumbnails to find a page
c. Tap a thumbnail to open the page.
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Security features

BlackBerry Access offers the following security featuers:

Feature Description

Remote data wipe Wiping data is a process that allows your administrator to remotely
erase data from your device when a violation or breach of a security
policy is detected, your network permissions are changed or revoked, or
you leave the organization.

When your device is wiped, BlackBerry Access data is removed.

Secure storage of browsing All BlackBerry Access browsing activity, including browser data, the
activity cache, and cookies, are encrypted and stored in a secure container
on devices. The secure container ensures that work data is stored
separately from personal data on devices.

Passwords You can change your password using BlackBerry Access settings.
S/MIME support You can read and write S/MIME encrypted and signed email messages in
BlackBerry Work.
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Legal notice

©2021 BlackBerry Limited. Trademarks, including but not limited to BLACKBERRY, BBM, BES, EMBLEM Design,
ATHOC, CYLANCE and SECUSMART are the trademarks or registered trademarks of BlackBerry Limited, its
subsidiaries and/or affiliates, used under license, and the exclusive rights to such trademarks are expressly
reserved. All other trademarks are the property of their respective owners.

Adobe and Flash are either registered trademarks or trademarks of Adobe Systems Incorporated in the United
States and/or other countries. Cisco WebEx is a trademark of Cisco Systems, Inc. and/or its affiliates in the
United States and certain other countries. Intel Core is a trademark of Intel Corporation in the U.S. and/or other
countries. Microsoft, ActiveX, Outlook, and Windows are either registered trademarks or trademarks of Microsoft
Corporation in the United States and/or other countries. Salesforce is a trademark of salesforce.com, inc. and is
used here with permission. All other trademarks are the property of their respective owners.

This documentation including all documentation incorporated by reference herein such as documentation
provided or made available on the BlackBerry website provided or made accessible "AS IS" and "AS AVAILABLE"
and without condition, endorsement, guarantee, representation, or warranty of any kind by BlackBerry Limited and
its affiliated companies ("BlackBerry") and BlackBerry assumes no responsibility for any typographical, technical,
or other inaccuracies, errors, or omissions in this documentation. In order to protect BlackBerry proprietary and
confidential information and/or trade secrets, this documentation may describe some aspects of BlackBerry
technology in generalized terms. BlackBerry reserves the right to periodically change information that is contained
in this documentation; however, BlackBerry makes no commitment to provide any such changes, updates,
enhancements, or other additions to this documentation to you in a timely manner or at all.

This documentation might contain references to third-party sources of information, hardware or software,
products or services including components and content such as content protected by copyright and/or third-
party websites (collectively the "Third Party Products and Services"). BlackBerry does not control, and is not
responsible for, any Third Party Products and Services including, without limitation the content, accuracy,
copyright compliance, compatibility, performance, trustworthiness, legality, decency, links, or any other aspect
of Third Party Products and Services. The inclusion of a reference to Third Party Products and Services in this
documentation does not imply endorsement by BlackBerry of the Third Party Products and Services or the third
party in any way.

EXCEPT TO THE EXTENT SPECIFICALLY PROHIBITED BY APPLICABLE LAW IN YOUR JURISDICTION, ALL
CONDITIONS, ENDORSEMENTS, GUARANTEES, REPRESENTATIONS, OR WARRANTIES OF ANY KIND, EXPRESS
OR IMPLIED, INCLUDING WITHOUT LIMITATION, ANY CONDITIONS, ENDORSEMENTS, GUARANTEES,
REPRESENTATIONS OR WARRANTIES OF DURABILITY, FITNESS FOR A PARTICULAR PURPOSE OR USE,
MERCHANTABILITY, MERCHANTABLE QUALITY, NON-INFRINGEMENT, SATISFACTORY QUALITY, OR TITLE, OR
ARISING FROM A STATUTE OR CUSTOM OR A COURSE OF DEALING OR USAGE OF TRADE, OR RELATED TO THE
DOCUMENTATION OR ITS USE, OR PERFORMANCE OR NON-PERFORMANCE OF ANY SOFTWARE, HARDWARE,
SERVICE, OR ANY THIRD PARTY PRODUCTS AND SERVICES REFERENCED HEREIN, ARE HEREBY EXCLUDED.
YOU MAY ALSO HAVE OTHER RIGHTS THAT VARY BY STATE OR PROVINCE. SOME JURISDICTIONS MAY

NOT ALLOW THE EXCLUSION OR LIMITATION OF IMPLIED WARRANTIES AND CONDITIONS. TO THE EXTENT
PERMITTED BY LAW, ANY IMPLIED WARRANTIES OR CONDITIONS RELATING TO THE DOCUMENTATION TO
THE EXTENT THEY CANNOT BE EXCLUDED AS SET OUT ABOVE, BUT CAN BE LIMITED, ARE HEREBY LIMITED TO
NINETY (90) DAYS FROM THE DATE YOU FIRST ACQUIRED THE DOCUMENTATION OR THE ITEM THAT IS THE
SUBJECT OF THE CLAIM.

TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW IN YOUR JURISDICTION, IN NO EVENT SHALL
BLACKBERRY BE LIABLE FOR ANY TYPE OF DAMAGES RELATED TO THIS DOCUMENTATION OR ITS USE,

OR PERFORMANCE OR NON-PERFORMANCE OF ANY SOFTWARE, HARDWARE, SERVICE, OR ANY THIRD
PARTY PRODUCTS AND SERVICES REFERENCED HEREIN INCLUDING WITHOUT LIMITATION ANY OF THE
FOLLOWING DAMAGES: DIRECT, CONSEQUENTIAL, EXEMPLARY, INCIDENTAL, INDIRECT, SPECIAL, PUNITIVE,
OR AGGRAVATED DAMAGES, DAMAGES FOR LOSS OF PROFITS OR REVENUES, FAILURE TO REALIZE ANY
EXPECTED SAVINGS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, LOSS OF BUSINESS
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OPPORTUNITY, OR CORRUPTION OR LOSS OF DATA, FAILURES TO TRANSMIT OR RECEIVE ANY DATA,
PROBLEMS ASSOCIATED WITH ANY APPLICATIONS USED IN CONJUNCTION WITH BLACKBERRY PRODUCTS OR
SERVICES, DOWNTIME COSTS, LOSS OF THE USE OF BLACKBERRY PRODUCTS OR SERVICES OR ANY PORTION
THEREOF OR OF ANY AIRTIME SERVICES, COST OF SUBSTITUTE GOODS, COSTS OF COVER, FACILITIES OR
SERVICES, COST OF CAPITAL, OR OTHER SIMILAR PECUNIARY LOSSES, WHETHER OR NOT SUCH DAMAGES
WERE FORESEEN OR UNFORESEEN, AND EVEN IF BLACKBERRY HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES.

TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW IN YOUR JURISDICTION, BLACKBERRY SHALL
HAVE NO OTHER OBLIGATION, DUTY, OR LIABILITY WHATSOEVER IN CONTRACT, TORT, OR OTHERWISE TO
YOU INCLUDING ANY LIABILITY FOR NEGLIGENCE OR STRICT LIABILITY.

THE LIMITATIONS, EXCLUSIONS, AND DISCLAIMERS HEREIN SHALL APPLY: (A) IRRESPECTIVE OF THE NATURE
OF THE CAUSE OF ACTION, DEMAND, OR ACTION BY YOU INCLUDING BUT NOT LIMITED TO BREACH OF
CONTRACT, NEGLIGENCE, TORT, STRICT LIABILITY OR ANY OTHER LEGAL THEORY AND SHALL SURVIVE A
FUNDAMENTAL BREACH OR BREACHES OR THE FAILURE OF THE ESSENTIAL PURPOSE OF THIS AGREEMENT
OR OF ANY REMEDY CONTAINED HEREIN; AND (B) TO BLACKBERRY AND ITS AFFILIATED COMPANIES, THEIR
SUCCESSORS, ASSIGNS, AGENTS, SUPPLIERS (INCLUDING AIRTIME SERVICE PROVIDERS), AUTHORIZED
BLACKBERRY DISTRIBUTORS (ALSO INCLUDING AIRTIME SERVICE PROVIDERS) AND THEIR RESPECTIVE
DIRECTORS, EMPLOYEES, AND INDEPENDENT CONTRACTORS.

IN ADDITION TO THE LIMITATIONS AND EXCLUSIONS SET OUT ABOVE, IN NO EVENT SHALL ANY DIRECTOR,
EMPLOYEE, AGENT, DISTRIBUTOR, SUPPLIER, INDEPENDENT CONTRACTOR OF BLACKBERRY OR ANY
AFFILIATES OF BLACKBERRY HAVE ANY LIABILITY ARISING FROM OR RELATED TO THE DOCUMENTATION.

Prior to subscribing for, installing, or using any Third Party Products and Services, it is your responsibility to
ensure that your airtime service provider has agreed to support all of their features. Some airtime service
providers might not offer Internet browsing functionality with a subscription to the BlackBerry® Internet Service.
Check with your service provider for availability, roaming arrangements, service plans and features. Installation
or use of Third Party Products and Services with BlackBerry's products and services may require one or more
patent, trademark, copyright, or other licenses in order to avoid infringement or violation of third party rights. You
are solely responsible for determining whether to use Third Party Products and Services and if any third party
licenses are required to do so. If required you are responsible for acquiring them. You should not install or use
Third Party Products and Services until all necessary licenses have been acquired. Any Third Party Products and
Services that are provided with BlackBerry's products and services are provided as a convenience to you and are
provided "AS IS" with no express or implied conditions, endorsements, guarantees, representations, or warranties
of any kind by BlackBerry and BlackBerry assumes no liability whatsoever, in relation thereto. Your use of Third
Party Products and Services shall be governed by and subject to you agreeing to the terms of separate licenses
and other agreements applicable thereto with third parties, except to the extent expressly covered by a license or
other agreement with BlackBerry.

The terms of use of any BlackBerry product or service are set out in a separate license or other agreement with
BlackBerry applicable thereto. NOTHING IN THIS DOCUMENTATION IS INTENDED TO SUPERSEDE ANY EXPRESS
WRITTEN AGREEMENTS OR WARRANTIES PROVIDED BY BLACKBERRY FOR PORTIONS OF ANY BLACKBERRY
PRODUCT OR SERVICE OTHER THAN THIS DOCUMENTATION.

BlackBerry Enterprise Software incorporates certain third-party software. The license and copyright information
associated with this software is available at http://worldwide.blackberry.com/legal/thirdpartysoftware.jsp.

BlackBerry Limited

2200 University Avenue East
Waterloo, Ontario

Canada N2K 0A7

BlackBerry UK Limited
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